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Sending Mail Messages

This screen allows you to prepare new mail messages and replies.

Addressing your message
The subject field
Confirmation of reading
Confirmation of delivery
Keeping a copy of your message
Urgent messages
Encryption
Signatures
Editing your message
Attachments
Other message options
Importing text from other sources



Addressing your message

Just as the postal service needs an address to be able to deliver a letter, WinPMail requires an address to 
be able to send your electronic mail. Depending on your system and network you might be able to use any
of several types of address, each slightly different. The following are the types of addresses WinPMail 
recognizes, which you can enter in the To, CC or BCC fields.

Local addresses: You can enter the NetWare username of any user on your file server, or on any other 
file server to which WinPMail can deliver, using the standard NetWare syntax (ie, USERNAME, or 
SERVER/USERNAME). You can look up local users using the User Lookup function.

Internet Addresses: If your system has an SMTP gateway, then you can enter any valid Internet 
address in the address fields.

NetWare MHS Addresses: If your system has an MHS gateway then you can enter any valid NetWare 
MHS address in the address fields. If you are using an advanced MHS transport, you can access MHS
direcory services from the Addresses menu.

You can also prepare distribution lists, or lists of addresses you use frequently.



The To: field of a message indicates the primary recipient of a message



A CC (carbon copy) recipient of a message is someone you want to "listen in" to the message you are 
sending to the primary recipient. CC recipients receive the message normally but their addresses do not 
appear in the To: field of the message.



Use a BCC (Blind Carbon Copy) when you want to send a copy of your message to someone other than 
the primary recipient without the primary recipient knowing you have done so. Unlike CC, when you use 
BCC, there is no indication in the primary recipient's copy of the message that you have copied anyone 
else. BCC is very handy for office politics.



An SMTP gateway allows you to send mail to machines on the Internet (a huge world-wide computer 
network), or to machines which use the Internet RFC821/822 message protocols. Almost all Unix systems
and many mainframe and minicomputer systems can receive mail using this protocol.



NetWare MHS is Novell's messaging system. There are several versions of it for both NetWare and non-
NetWare environments. WinPMail supports all versions of NetWare MHS, including NetWare Global 
MHS. Ask your system administrator if you're unsure whether or not this option is available on your 
server.



The Subject field

Enter a short summary of your message in the subject field. Because the recipient will use the subject line
as a filing key, you should try to make it as descriptive and helpful as possible. When replying to a 
message, it is customary for the subject to be Re: <the original subject>: WinPMail will automatically 
format the subject this way for you when preparing replies.

The subject field can be up to 64 characters long.



Confirmation of reading

If you want to be notified when the recipient reads your message, check the confirm reading box in the 
message editing window. A small message will be sent back to you when the message is read. Note: the 
recipient must be using a version of Pegasus Mail for receipt confirmation to work. Some MHS mailers 
may also be able to provide receipt confirmations.

The System administrator can allow users to refuse confirmation of reading because many people feel that
it is an invasion of privacy. If you attempt to mail to a local user who will not provide confirmation of 
reading, a small dialog will appear when you send the message advising you of this. If you mail to a non-
local PMail user who will not permit confirmation of reading you will not receive any notification at all.

The confirm reading control is "sticky" - WinPMail will remember its setting from message to message 
and between sessions.



Confirmation of Delivery

Checking the confirm delivery box in the message editing window tells WinPMail to ask for confirmation 
that your message has been delivered successfully. Confirmation of delivery differs from confirmation of 
reading in that you are only advised that the message has been delivered to the recipient, not that it has 
been read.

Confirmation of delivery is always available if you are using NetWare MHS. You will never get 
confirmation of delivery on local mail (because WinPMail will tell you immediately if it fails to deliver 
your message). With Internet mail, you may or may not receive confirmation of delivery, because there 
are no guaranteed ways of asking for it.

The confirm delivery control is "sticky" - WinPMail will remember its setting from message to message 
and between sessions.



Keeping a copy of your message

If you want to keep a copy of the messages you send, check the copy self box in the message editing 
window. WinPMail will file a copy of your message in a folder called "Copies to self" which it will create
automatically when necessary.

If your "Copies to self" folder becomes too full, you can force WinPMail to create a new copyself folder 
by renaming the existing one. Note that you must change the short name as well as the long name when 
doing this.

The copy self control is "sticky" - WinPMail will remember its setting from message to message and 
between sessions.



Urgent Messages

Check the urgent box in the message editing window if you want your message to be sent at the highest 
priority available on the message transport your system uses. The effect of setting this flag will vary from 
system to system. Many MHS mailers will recognize it, as will some Internet mailers. Pegasus Mail 
displays urgent messages at the top of the new mail folder in red text, and sends a different new mail 
notification to the recipient to indicate that the message is urgent.

Note: You should use the urgent flag with care: urgent messages can be annoying, and overuse of the 
feature seriously impacts on its usefulness.



Encryption

If your message contains sensitive or private information, you might want to encrypt it. An encrypted 
message is scrambled, and can only be read by someone who knows the correct password.

To encrypt your message, click the encrypt button in the message editor. A small dialog will open into 
which you should enter the password for the message. The password should have from five to eight 
characters and is case-sensitive - so FOOBAR and foobar are different passwords. Press OK to add the 
password, or Cancel to remove it. WinPMail will encrypt the message using your password when it sends 
it.

The recipient must know the password, so you will have to make arrangements in advance to agree on a 
suitable choice. Don't forget the password! If you forget it, you will never be able to read your message 
again; even the author of WinPMail cannot break the encryption method it uses.



Signatures

A signature is a small fragment of text which WinPMail will automatically add to the end of messages 
you send. You should usually put your name, address and phone/fax number in your signature, although 
some people like to place a witty saying or other text there as well.

WinPMail supports separate signatures for each type of message you can send - Local, Internet and MHS:
you can create and edit signatures using the option on the preferences submenu of the file menu.

To suppress the addition of a signature to a message, click on the no signature button in the message 
editing window. You may need to omit your signature when sending mail to some Internet list servers.



Editing your message

Edit your message in the large message box at the bottom of the message editing window. The message 
text will word-wrap when it reaches the right hand margin, or you can press <Enter> to end a line at any 
time. You can cut text from and paste text into your message using the Edit menu.

The spelling checker option in WinPMail is not enabled in version 1.0. It will be available in the next 
release of the program.

You can store abbreviations for commonly-used text in WinPMail's glossary, and expand it at any time by
pressing <Ctrl+/>.

Send your message at any time by clicking the Send button, or by pressing <Ctrl+Enter>.



Attachments

You can attach files to your mail message by clicking on the Attach button in the message editing 
window. A dialog will appear which allows you to choose files and control the way WinPMail will deal 
with them.

WinPMail will handle your attachments differently, depending on the destination of the message. You 
have considerable control over this process if you wish to have, although WinPMail's automatic handling 
is usually more than adequate for all situations.

Choose any of the following items for more information on attachments:

Selecting files to attach
Indicating the file type
Attachment encoding



Selecting files to attach

Before you select files to attach to your message, make sure that the File type and Attachment encoding 
fields in the dialog are set correctly, then use either of the two following methods:

Use the file and directory lists at the bottom of the window to navigate your disks. Double-clicking a 
filename will add it to the attachment list with the current settings of the file type and attachment 
encoding fields.

Type in the name (including an optional DOS path) of the file in the filename window. When you 
press <Enter> or click Add, WinPMail will add the file to the attachment list, or if you have entered a 
directory name, will change the file and directory list boxes to reflect the new directory.

You can remove attachments from the attachment list by highlighting them and clicking Remove. You 
cannot change the settings for an attachment once you have added it to the list - remove it and re-add it 
instead.



File type

You can tell WinPMail what type of file you are attaching by choosing from a predefined list of file types.
The file type information is optional and is currently used only for informational purposes - the recipient 
will usually see then file type when examining the list of files attached to the message.

Future versions of Pegasus Mail are likely to use the file type information to provide attachment viewing 
facilities, or to launch the original application with the attachment, so you should get into the habit of 
filling it in.

If you are uncertain of the type of file, you should use Unknown, the default choice.

Note: Pegasus Mail will not perform file conversion - WinPMail will not convert an MS-Word file to 
WordPerfect format even if you indicate WordPerfect format here - it will simply convey the wrong 
information.



Attachment encoding

When you send an attachment, it cannot always be transmitted as-is. Sometimes it is necessary to package
the attachment in a particular way so that the mail transport system or the recipient's mailer can 
understand it. WinPMail will always make sensible default choices about attachment encoding - you 
should only need to change the attachment encoding in very special cases. WinPMail supports the 
following attachment encodings:

WinPMail decides. The default setting, this tells WinPMail to do whatever is appropriate based on the 
way it sends the message. Attachments to local and MHS addresses will not be encoded in any way, 
while attachments to Internet addresses will be uuencoded prior to transmission.

No encoding. Instructs WinPMail not to encode the attachment at all. This is an extremely dangerous 
choice in some cases, particularly for Internet mail. Use it only if you know that the attachment is a 
plain text file with no high bit characters.

ASCII text. Indicates that the file is plain text with no formatting or high-bit characters. WinPMail 
will actually send the attachment as a separate message rather than as an attachment.

UUencoding. A scheme used widely on the Internet. If you are mailing via the Internet, or to a user on
a Unix or mainframe system this encoding is a good choice.

BinHex. Used heavily in the Macintosh world. BinHex is a good format, containing a certain amount 
of error checking and compression. Because it is not widely used outside the Macintosh world, you 
should check in advance that the recipient is able to deal with BinHex-encoded files.



Other message options

Select Other message options from the Message menu and a dialog will open which allows you to control
less frequently-used features for your message.

BCC. Enter any BCC. addresses in this field.

Send replies to. If you want replies to your message to go to an address other than your own, enter 
that address in this field.

Message is obsolete after. If your message is only meaningful for a certain length of time, enter the 
time after which it is obsolete in this area. Obsolete messages appear grey in the folder window, and 
there is a browser command which will purge all obsolete messages. Obsolete mail mail also be 
purged by utilities run by the system manager.

Message width. This field allows you to specify the average length of a line of text in your message. 
WinPMail will adjust the margin of the message editor so that approximately the number of 
characters you specify will fit on a line. You cannot enter a width wider than the current width of the 
editing window. Click use as default to use the value you enter for all future messages.

Average tab width. By default, WinPMail obeys the standard Windows convention that the <Tab> key
moves from field to field in a dialog. If you enter a width in this field, however, WinPMail will insert 
the <Tab> characters in the message instead. You can only change the tab width if tabs were enabled 
when you started the message. You can enable tabbing for all future messages by clicking use as 
default. The width you enter is an average based on the average width of characters in the current 
font; it will only be exact if you use a monospace font such as Courier.



Importing text from other sources

You can add text from other applications to your message in two ways.

Cut and paste. You can use the standard cut, copy and paste commands on the Edit menu to move text 
around within Windows.

Import menu option. The Import file into message option on the Message menu allows you to read a text 
file into your message. A dialog will appear which allows you to navigate using standard file and 
directory lists, or type the name of the file in directly. Note: the file must be a text file for this option to 
work. Word processor files are usually not text files.



Distribution Lists

WinPMail can accept up to 180 characters in any address line. If you need to send a message to more 
addresses than will fit in this space, or you have lists of users to whom you mail regularly, you can create 
distribution lists.

A distribution list can be any text file containing addresses, one per line, but it's generally easier to use 
WinPMail's distribution list manager, which you can access by pressing the button on the button panel, by
pressing <F6>, or by selecting Distribution lists from the Addresses menu.

Creating a distribution list
Distribution list options
Using distribution lists



Creating a distribution list

To create a distribution list, press <F6> and click on the New button in the selector window. A dialog will 
open prompting you for a long name for the list and an optional file name. Complete the dialog then click 
OK. You will be returned to the selector window.

Now, hightlight the list you created and press the Edit button. A window will open in which you create 
and control your distribution list. The title you gave your list when you created it appears in the Title 
field.

To add addresses to your distribution list click in the address list area and either type in the addresses or 
select them from address books or the local user list. Make sure that you have only one address per line in
the list. Any valid address can be entered in the list.

Distribution list options



Distribution list options

There are several ways you can control and customize the operation of your distribution lists.

To field: Entering an address in this field will force PMail to suppress enumeration of addresses when you
use the list. Instead of showing every member of the list, the To: field will contain only what you enter 
here.

Reply to: If you want to direct replies to list mailings to a particular address, enter it here. A reply-to field 
you set in the list will override any in the message.

Confirm reading, confirm delivery, urgent, no signature: These controls duplicate the same features in the 
message editor. If you set them for the distribution list they will override the values you use when you 
compose the message.



Using a distribution list

Tell WinPMail to use a distribution list in one of two ways:

1: While composing your message, open the distribution list selector by clicking the button in the button 
panel, by pressing <F6> or by choosing Distribution lists from the Address menu, and double-click on the
address you want to use. WinPMail will paste the appropriate file name into the address field of your 
message.

2: Type an '@' followed immediately by the DOS path to the file containing the distribution list. You will 
not normally use this method, but it may be convenient if you have a mailing list in a suitable format 
which was not created in WinPMail.



Glossaries (abbreviations)

WinPmail allows you to store abbreviations for commonly-used text strings which you can expand at any 
time with a single keypress. To create a glossary entry, choose Edit/create from the Glossary submenu of 
the Edit menu.

In the Glossary dialog, a list of abbreviations appears on the left-hand side of the screen, while the full 
text of the currently-selected abbreviation appears in the edit window to the right. To change a glossary 
entry, simply select it in the list and edit it in the editing window. WinPMail. Adding a glossary entry is 
equally simple - just click the Add button, provide an abbreviation, and edit as before. You can copy and 
paste into your glossary texts using the buttons in the dialog.

To expand a glossary entry in your message, simply type the abbreviation, make sure the cursor is at its 
end, then press <Ctrl+/>. In WinPMail 1.0 you can only expand glossary entries in the message editor. 
Future versions will allow you to expand them in any text field.



Browsing mail

The folder browser allows you to manage the mail you receive. It provides functions for moving, copying,
deleting, forwarding, printing and replying to messages. Special options and functions for sorting folders 
are located on the Folder menu which appears at the end of the menu bar when a folder window is 
frontmost.

The folder selector
Copying and moving messages
Deleting messages
Forwarding messages
Printing messages
The Folder menu



A mail folder is simply a place where mail messages are stored. The new mail folder is a special folder 
which changes as you receive, read and delete mail, but you can also create other folders for long term 
storage of messages you wish to keep. Folders can have long descriptive names to aid in filing.



The folder selector

When you ask to open a folder, or if you choose the Move or Copy options in the folder window, the 
folder selector will open. In this dialog you can create new folders, rename existing ones and delete 
folders you no longer require.

The folder selector shows a list of all the folders available to you. Folders in the list which appear in blue 
are system folders: you can read from them, but you might not be able to alter their contents.

At the right-hand edge of the entry for each folder is a pair of numbers, representing the number of 
messages in the folder and the number of unread messages in the folder respectively. Unread mail can 
appear in folders as a result of new mail filtering rules, or when you copy a message you have not read 
from the new mail folders. Folders containing unread mail appear in the list in green.



Copying and moving messages

If you want to make a copy of message in a mail folder, or to move the message from the current folder to
another, click on the Copy button or the Move button. The folder selector will open listing the available 
folders. You can create a new folder if you wish, or else double-click on the destination folder.

If the message you are copying has not been read, the unread messages counter which shows for the 
folder in the folder selector will increase by one.



Deleting messages

To delete messages you no longer need, highlight them in the folder and click the Delete button, or press 
the <Del> key.

Deleted message tracking: WinPMail has a preferences option which can allow you to recover mail 
messages you delete accidentally. If you have checked Preserve deleted messages until exit in your 
preferences WinPMail will not delete messages from the folder - instead it will move them to a special 
folder called Deleted messages which it will create as necessary. When you exit from WinPMail, the 
deleted messages folder is removed and the messages are deleted once and for all. Any time up to the 
point when you exit from WinPMail you may open the deleted messages folder and move or copy 
messages you wish to recover to other folders.

Note: you should not enable deleted message tracking if you are running in an environment with low or 
restricted disk space.



Forwarding messages

If you wish to refer a message to another person or people, then highlight it in the folder list and click the 
Forward button, or press <F>. A small dialog will open prompting you for the address to which the 
message should be forwarded. If you click Edit before forwarding, then a message editor will open 
allowing you to change the contents of the message before it is sent, otherwise it will be forwarded at 
once.

Note: it is a limitation of WinPMail v1.0 that you cannot pick addresses from address books or other lists 
in the forwarding window - you can only type the address in. This restriction is temporary and will be 
removed in the near future.



Printing messages

You can print messages from the message reader or from the folder list by pressing <Ctrl+P>, or by 
selecting Print from the file menu. The message reader also has a Print button.

When you ask to print a message, the print setup dialog will appear showing the last settings you used. 
WinPMail remembers your print settings from session to session. The currently selected printer (or the 
default Windows printer if this is the first time you have printed your message) appears in the list control. 
You can select other installed printers by clicking on the down arrow at the right-hand end of the control.

The Margin fields allow you to specify a printing margin for the Top/Bottom and Left/Right of the page. 
The default is 20mm (one inch = 25.4mm) all round. WinPMail will not permit you to set margins 
narrower than 10mm. 

The Font button allows you to select a font from those supported by your printer.

The Setup button brings up the standard Windows printer setup dialog, which will vary from printer to 
printer.



The folder menu

When a folder window is frontmost, a Folder menu appears at the right of the menu bar. The folder menu 
contains options which are less frequently-used or are more specialised than the button functions in the 
window.

Searching for text in the folder
Sorting the contents of the folder
Special folder options

The last entry on the menu allows you to select the font the folder window will use to display the list. This
setting is global to all folders and is remembered from session to session. You cannot choose very large 
fonts for the folder display without truncating some of the information it shows. A 14-unit font is 
normally a good size.



Searching for text in a folder

The Find and Find again options on the folder menu allow you to search the contents of the current folder 
for a piece of text. Type the text you want to look for in the editing field. The text can contain * and ? 
wildcard characters.

Search message headers only: If you want WinPMail to restrict its search to the special headers at the 
start of the mesage, check this box. Searching headers only is considerably faster than searching the 
whole message, and is appropriate if you are interested in the subject of a message or who it is from.

Mark all matching messages: Usually WinPMail opens a message reader and displays the first message it 
finds which matches your search criteria. If you want to select all messages in the folder which match 
your criteria instead of reading them, click this box. This option is handy if you want to tag all messages 
on the same subject for moving or copying.

Hint - searching for a specific header: If you only want to search for a particular header containing your 
search string, make sure that search message headers only is checked, then enter the search text like this 
example, where we only want messages where the From: field contains the word Otago:

From:*otago*



A wildcard character is one which matches any character or group of characters in the text searched. In 
WinPMail the ? character matches any single character (so "?illy" will match both "Willy" and "Billy"), 
while the * character matches any number of characters (so "j*on" would match "johnson", "johnston" or 
"john's son").



Sorting folders

The second group of entries on the Folder menu allow you to specify how the folder should be sorted. The
default for folders is Sort by date. A check mark appears next to the entry which indicates how the folder 
is currently sorted.

WinPMail remembers the last sorting option you selected from session to session.



Special folder options

The last entry on the Folder menu has a submenu containing some specialised functions.

UUdecode message: Sometimes WinPMail will be unable to recognize that a message is actually an 
attachment sent using a special encoding method called uuencoding. This usually happens if the 
attachment was sent across the Internet by someone using a mail system other than Pegasus Mail. If you 
receive a message like this, you can force WinPMail to decode it by highlighting it in the list and 
selecting this option. WinPMail will prompt you for a filename and will attempt to decode the message 
for you.

Un-BinHex message: BinHex is another special transmission format like uuencoding (see above), 
commonly used on Apple Macintoshes. If you receive a BinHexed message which WinPMail does not 
recognize as BinHexed, you can force it to unpack it using this option.

Note: BinHexed files from Macintosh users may be useless to you on a PC. The Macintosh has a filing 
system quite unlike that of any other computer and its files are often only usable on other Macintoshes. 
Some programs such as WordPerfect and MS-Excel create data files which are compatible on both 
platforms, but not all do. If you find you cannot use the attachment when you extract it, this may well be 
the reason.

Delete all expired messages: WinPMail allows you to set an expiry, or obsolescence date for a message - 
a date after which the message is meaningless; messages which are past their expiration dates appear grey
in the folder window. This command instructs WinPMail to delete all expired messages from the folder, 
and only works in the New Mail folder.



Address books

WinPMail's address books allow you to store electronic mail addresses and other information about 
people with whom you correspond. You can create as many address books as you wish, and the system 
administrator can also create address books which everyone can see (these appear in blue in the address 
book selector window).

The address book selector
Creating addressbook entries
Using addressbook entries in your mail
Searching address books
The address book menu



The address book selector

When you click on the address books button, or choose address books from the Addresses menu, the 
address book selector window will open. In this dialog you can create new address books, rename 
existing ones and delete address books you no longer require.

The selector shows a list of all the address books available to you. Address books in the list which appear 
in blue are system-wide address books available to all users: you can read from them, but you might not 
be able to alter their contents.

To open an address book, either double-click its entry, or highlight it in the list and click on the Open 
button.

Naming address books: when you create an address book in the selector, you can give it any name you 
wish up to a maximum of 50 characters. There are no restrictions on the names you can use in the address 
book long name. If you choose to specify the short name (or filename) for the address book, you must 
enter a legal DOS filename no longer than 8 characters with no extension. Usually, you will leave the 
short name field blank and allow WinPMail to choose a filename for you.



Creating address book entries

When you have opened an address book, a window will open listing the contents of the book in an 
abbreviated form. If you click on an entry in the list, all the details from that entry will appear in the 
information pane at the bottom of the address book window.

To add an entry to your address book press the Add button. A simple data-entry dialog will open 
presenting you with a blank entry template. Fill in the fields and when you are satisfied with what you 
have entered, click the OK button. The fields which you must complete in this screen are the following:

Name (alias): The person's name. You can use what you enter in this field as an address in any address 
field - it is generally easier to remember that someone is called Peter Smith than to remember his address. 
This use of the name as an address is called aliasing. This field may not contain a comma.

Key: A short search key for the entry. WinPMail allows you to sort the address book either by name or by 
key, so the key field gives you an alternative sorting option.

E-mail address: The person's electronic mail address. Any single valid address can be entered in this field,
including distribution lists and NetWare groups. You may not use an alias in this field.

All other fields in the address book are yours to use in any way you wish.



Using address book entries in your mail

You can use your address books in your mail in three distinct ways

1: You can double-click on an entry in your address book to start a new mail message using that address 
and any others selected in the book.

2: You can click on the Paste button on the address book window. Any highlighted addresses will be 
copied into the last active field in the message you are editing.

3: You can drag the address entries you want to use to any edit control and drop them there. Note that the 
edit control need not be in WinPMail - it is possible to drag addresses from WinPMail to edit controls in 
other applications, such as the Windows Notepad program.

Depending on the setting in the address book menu, WinPMail will paste either the alias (the default) or 
the actual e-mail address into the destination field: you may use either approach depending on your 
preference.

Limitations:    Most address fields in WinPMail can only accept at most 180 characters. If you have 
selected addresses with more characters than will fit in the field, WinPMail will issue a warning. When 
this happens, you might have to consider creating a distribution list.



Aliasing happens when you use the name field from an address book instead of the e-mail address. 
WinPMail will accept either as an address: if you use the name, then WinPMail will look up the real e-
mail address at send time. You may prefer to use aliases over e-mail addresses because it is generally 
easier to remember someone's name than their address.



Searching address books

The quickest way to search your address book is to type the first few characters of the name or key you 
want to find. Depending on the current sort order of the address book WinPMail will move the highlight 
to the first entry in the book with a key or name which matches what you type. This process is called 
speed searching.

For more comprehensive searching, the address book menu contains a Find command which you can use 
to locate or select entries in your address books. When you choose Find, a small dialog will open asking 
what you want to search for. Enter the string you want to find. If you want WinPMail to search the whole 
address book marking all entries which match your criteria, click the select all matching entries button.

You can repeat the last search you made by selecting Find again from the address book menu. The search 
text is global, so you can search in one book, then open another and choose Search again to continue your
search in the new book.



The address book menu

When an address book is the frontmost window in WinPMail, the Addressbook menu option becomes 
available at the right of the menu bar. This menu contains actions and commands specific to address 
books.

The first two commands, Find and Find again, allow you to search for text in the address book.

The next two options control the sort order for the addressbook. Unless the address book is a system-wide
entry, the sort order is remembered for each address book separately between sessions. The sort order 
which is currently active shows a checkmark in the menu.

The final three options on the menu control the way WinPMail will use addresses from the address book. 
Like the sort order, these settings are local to each non-system address book and are remembered between
sessions. The first two options in the group allow you choose whether WinPMail should paste the alias or 
the actual e-mail address into messages when you drag and drop or press the Paste button. The default is 
to paste the alias. 

The last option on the menu allows you to tell WinPMail whether or not to resolve aliases in this address 
book. Alias resolution is the process of taking a name and finding the e-mail address which matches it 
from the address book at send time. The process of alias resolution can take quite a while if you have 
many or large address books, so you may want to disable it for some or all of your books. By default 
WinPMail resolves aliases in all address books.



The button panel

WinPMail's button panel is a small floating window which gives you quick access to some of the more 
commonly-used features in the program. If the button panel is closed, you can open it at any time by 
selecting Button Panel from the Window menu.

WinPMail remembers the location and state (open or closed) of the button panel between sessions. You 
can also choose between having the button panel in vertical or horizontal format using the option in your 
general preferences.

From left to right (or top to bottom in vertical mode) the buttons in the button panel provide access to the 
following functions:

Send mail allows you to start a new mail message
Read new mail allows you to browse your new mail folder
Mail folders allows you to browse other mail folders
Address books allows you to manage your address books
Dist lists allows you to manage your distribution lists



Preferences

WinPMail allows you to customize many aspects of the way it works to suit your own tastes. The settings 
you make which control this are called your Preferences, and are stored in a file called WINPMAIL.PRO 
in your newmail directory.

Preferences fall into two classes - implicit preferences, such as the location of windows on the screen and 
the values you set in the controls in the message editor. WinPMail remembers implicit preferences 
without you having to do anything more.

The other class of preferences are explicit preferences, or ones where you actually instruct WinPMail to 
operate in a particular way. Explicit preferences are changed using the Preferences submenu of the File 
menu. The following options are available there:

General settings
NetWare MHS settings
Signatures
Home mailbox location
Extended features



General settings

The following items can be changed in the General Settings dialog:

Personal name: WinPMail attaches whatever you enter here to your address when you send messages, 
making it easier for the recipient to identify who you are. You should make this entry simple and clear. 
Your personal name should consist only of letters and digits.

Open new mail at startup:    If you check this box WinPMail will automatically open your new mail folder
for you when you run it.

Preserve deleted messages until exit:    If you check this box, WinPMail will save any messages you 
delete in a special folder called Deleted Messages which will be cleared when you exit; this option can 
allow you to save messages deleted accidentally.

Ask for NetWare password at startup:    Check this and WinPMail will prompt you for your NetWare 
password when you run it. It will not run unless you enter the password correctly. This option adds 
security to your mail if you are away from your desk a lot.

Vertical button panel (when open):    The button panel usually has a horizontal layout, but if you check 
this box WinPMail will create it in a vertical window. This setting takes effect as soon as you close the 
preferences dialog.

Offer advanced options for replies:    WinPMail has an alternative reply dialog which allows you to select 
particular addresses from the original message for your reply. If you want to use the advanced reply 
dialog instead of the default simple reply dialog, check this box.

Folder for copies to self:    If you click on the Select button, WinPMail will open the folder selector and 
allow to create or select a folderwhere your copies to self will be stored. By default the folder is called 
"Copies to self" with the DOS filename "copyself".

Default reply address:    If you want to specify an address which WinPMail will automatically copy to the 
reply-to field of every outgoing mail message, enter it here. There is usually no need to use this option -
you might use it if you routinely prefer to receive your mail on another system for instance.



NetWare MHS preferences

If a version of Novell's MHS transport is installed on your system, then this option allows you to 
configure the way WinPMail will interact with MHS for you. In general, the options in this screen are 
quite complex and you should change them only if instructed to do so by your MHS administrator.

My NetWare MHS username:    This is the username by which MHS addresses you. It may be the same as 
your NetWare username but need not be. If you are using an SMF-71 transport such as NetWare Global 
MHS, you can enter a full SMF-71 address (up to 128 characters long) in this field. You may need to enter
a complete address here if you are not a member of the default MHS workgroup.

Mailbox name:    This is the name of the directory in the MHS tree where your MHS new mail folder is 
located. If you are using MHS 1.5, it will usually be the first eight characters of your NetWare username 
(which is the default WinPMail uses) but it may be different, and is likely to be different if you are using 
an SMF-71 transport.

New mail folder:    This is the name of the folder in your new mail folder where WinPMail should expect 
to find your new mail. In technical terms, this field should contain the name of your preferred mailer 
which may or may not be PMail.

Check the MHS newmail folder:    By default, MHS creates a new mail directory for every user called 
MHS, and makes this directory the preferred mailbox for the user. Checking this control tells WinPMail to
check the MHS new mail folder as well as any other you name in the New mail folder field. Checking this
option is harmless at worst, although it may slow down checks for new mail a little bit.



Signatures

A signature is a small fragment of text which WinPMail will automatically add to the end of messages 
you send. You should usually put your name, address and phone/fax number in your signature, although 
some people like to place a witty saying or other text there as well.

WinPMail supports separate signatures for each type of message you can send - Local, Internet and MHS.



Home mailbox location

Your home mailbox is where all your mail folders, distribution lists, address books and other PMail 
related files (except unread new mail) are stored. By default, it is located in a special directory on the file 
server, but you can specify an alternative location for it using this option.

Note: before using this option, make sure that all windows in WinPMail are closed except the button 
panel (which can also be closed but does not have to be).

You may want to change your home mailbox location if you have limited space on the file server, if you 
are concerned about the privacy of your mail, or for other reasons. You can also have more than one 
mailbox and change between them using this dialog - you might want to do this if you received mail at 
your address for more than one person or organization.

To change your home mailbox location, type in the new path in either DOS or NetWare format. If you 
want to change the location but leave all your mail files where they are, make sure that the move mailbox 
contents to new location button is not checked (this is how you would implement more than one mailbox 
as described above). If you have moved your home mailbox but want to revert to the original location on 
the file server, press the Default button.

If you have chosen to move the contents of your home mailbox, WinPMail will do so as soon as you click
OK.



Extended features

Extended features are special Pegasus Mail features which you only have if the system administrator has 
explicitly granted them to you. If you have been granted access to extended features, then the Extended 
features menu option in the Preferences sub-menu will be available, other wise it will be grey and you 
cannot select it. Choosing this option opens a dialog which allows you to change the following:

Autoforwarding: Pegasus Mail supports autoforwarding, or the redirection of your mail to another 
account. You can autoforward either mail delivered to you from local addresses, mail received from the 
Charon or Mercury Internet gateway, both or neither. It is possible to forward one type of mail but not the 
other. To set autoforwarding, place the forwarding address in either or both of the available autoforward 
fields. You can forward local mail to any address WinPMail can understand including NetWare groups 
and distribution lists. Internet mail can only be forwarded to simple local addresses or to Internet 
addresses. Mail arriving via NetWare MHS cannot be autoforwarded.

Deliver mail even if autoforwarding: check this box if you want Pegasus Mail to leave a copy of mail as 
well as forwarding it when you have autoforwarding addresses set. This option has no effect if you are not
forwarding your mail.

Allow 'confirmation of reading' requests. If you uncheck this box, then WinPMail will not return 
confirmation that you have read messages when it is requested. Local users will be told the moment they 
send the message that no confirmation will be supplied, but Internet and MHS mail will receive no such 
notification.

Advise of new mail via broadcasts: When this box is checked, Pegasus Mail will send a NetWare-style 
broadcast message to indicate that a new mail message has arrived. If you find the broadcast messages 
annoying but do not want to use the NetWare CASTOFF command to disable them, uncheck this box..

Disable mail delivery to this address: If checked, it will not be possible to send mail to this address.



Reading mail

To read a message in a folder, either double-click on it or select it and press the Open button.

While you are reading a message, a button bar with most of the options available in the folder window 
appears. There is also a Print button, which has the same effect as choosing Print from the File menu, and
a pair of buttons marked Next and Prev. The Next button replaces the message in the reader window with 
the next message from the folder, while the Prev button replaces the message with the one before it in the 
folder. If you hold down the Shift key while you press Next or Prev, the message you are leaving will be 
marked in the folder selector before the new one is loaded.

The Copy command on the Edit menu will copy lines from the message reader for pasting elsewhere. By 
using the Ctrl key while selecting lines you can select separate groups of lines simultaneously in the 
message, and copy them all with one command.

Options specific to the message reader appear in the Message menu.



The Message menu

While reading mail, the Message menu appears at the right of the menu bar. The menu offers four options 
specific to the message reader:

Save window size:    When you choose this option, WinPMail will save the current size of the message 
reader window to your preferences. All future message reader windows you open will open at this size. 
You cannot save the location of a message reader window because doing so would result in messages 
overlapping onscreen, thus being difficult to select.

Show all headers:    By default, WinPMail displays only headers in the message which are meaningful to 
the reader, suppressing all others. If you need to see the message exactly as it was delivered, with its 
headers intact, select this option. Note: Unlike the DOS version of PMail where the show all headers 
option is global and affects all subsequent messages, WinPMail only applies this option to the current 
message.

Extract message to file:    If you want to make a copy of this message in a DOS text file, perhaps for 
inclusion in another program, then select this option. You will be prompted for a filename - when you 
click OK, WinPMail will extract the contents of the message to the file.

Font...: Use this option to change the font you use to view messages. This change is global, and affects all
messages already open and subsequently opened in WinPMail.



Headers are the special set of lines at the start of a mail message which contain addressing and other 
machine-readable information about the message. Headers are rigidly formatted and vary widely from 
system to system; many headers in a message are only of interest to the mail transport system and are 
meaningless to a human reader.



The MHS Directory Service

If your system has an MHS SMF-71 message transport such as Novell's NetWare Global MHS, then the 
directory service provided by that system (called the Extract File) is available to you from within 
WinPMail. To open the MHS Directory Service, choose the entry on the Addresses Menu.

The MHS directory service list behaves like a read-only address book: you can double-click on an entry 
to start a new message using the entry as an address, you can drag addresses from the list window to any 
address field, or you can click on the Paste button to paste the selected addresses into the last address 
field you were using.

You can also speed search through the list by typing the first few characters of the name you are looking 
for.

For technical reasons, you should close the extract file window as soon as you can after using it, since 
NetWare MHS may not be able to update the list while you have the file open.






